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Target Audience: 
X Accounting X Account Executive 
 Non-Insurance Accounting X Customer Service Representative 
X Administrative  New Producer 
X Principal X Experienced Producer 
X General X IT 
 Human Resources  Other:  (describe) 
 

Seminar Type: Microsoft Products, Reports  
 
 
Seminar Level:  Basic/ Introductory:  An introductory level course is basic in nature and addresses 
fundamental concepts. We expect attendees to have a basic level of insurance knowledge, have been 
oriented to an agency’s processes. For functional courses, it is not necessary for the attendee or 
participant to have previous knowledge of the agency management system or software program. 
 
 
 
 
 

Basic Excel  //  PAGE  2 
 

Applied Client Network  |  www.appliedclientnetwork.com 

 



 
 SESSION HANDOUT 
 Basic Excel 

 
 
 
 
Class Description:  This class will cover basic Excel tools from Navigating Excel through 
Sorting, Subtotaling and Filtering data using familiar Book of Business and Production 
data. 
 
Learning Outcomes:   

• Attain a comfort level with Excel  
• Master tools like Copy/Paste, Resizing Rows/Columns, Formatting Cells, Print 

Setup, Basic Formulas, Sorting, Subtotaling and Filtering 
• Get excited with how fast and easy it is to analyze data using Excel. 
 

Assumptions:  This seminar is based on the following 
TAM Version 2013 
Microsoft ® Excel Version 2010 

Sample Workbook:  Excel Sample Workbook 
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Navigating Excel  
 
An Excel File is called a Workbook.  A Workbook contains Sheets that each has: 

• Number of Columns – 16,384 
• Number of Rows – 1,048,576 

 

Help  is located in the upper right hand corner or click [F1]  
 
Click on a Tab and you are presented with a Ribbon that contains Groups of 
Commands. 
 
The Formula Bar displays what is actually in the cell (could be text, or a formula).   
NOTE:  You may not see all the text if the column/row is not sized properly, so be sure to 
check the Formula Bar for what is actually in the cell. 
 
The Cursor can look many ways: 

•  Select Mode (Normal Mode) 

•   Resizing Cursor – use to resize columns / rows 

•   Click and Drag Cursor 

•   Highlight a Column or a Row of Data 

•   Auto fill– appears in bottom right hand corner – (Smart Tag) AutoFill Options 
Button 
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Select All  
Click on the cell above Row 1 and to the left of Column A.  This will highlight the entire 

spreadsheet.    
OR  
[Ctrl-A] on your keyboard.  If the worksheet contains data, and the active cell is above or 
to the left of the data, pressing [Ctrl-A] selects the current region.  Pressing [Ctrl-A] again 
selects the entire worksheet). 

Keyboard Shortcuts 
[Ctrl-A]   Select All   
[Ctrl-C] Copy  
[Ctrl-V] Paste 
[Ctrl-Z] Undo 
[Ctrl-Home] Return to Cell A1 
[Ctrl-End] Last Active Cell 
[Shift-End-Right Arrow] Select Adjacent Columns of Data 
[Shift-End-Down Arrow] Select Adjacent Rows of Data 
[Ctrl-Shift-End]  Select from current cell(s) to the end of the USED portion of a worksheet 
[Ctrl-Down Arrow]  Moves the cursor to last active cell in the column 

Autofit Columns and Rows 
Click the Select All button. 
Place your cursor (now it’s the Resizing Cursor) between any two 
Column Letters or Row Numbers and double click.  All the 
columns or rows will now be resized to fit the largest data in each 
column. 

Freeze Panes 
You can Freeze Rows and/or Columns so as you navigate your worksheet you will always 
see the Rows or Columns that were frozen. 

• Click in the cell directly below and to the right of the column and row you want to 
freeze. 

• Click the View tab, Window group, Freeze Panes 
• Click Freeze Panes 

 
NOTE:  You can also choose Freeze Top Row or Freeze First Column. 
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Format Numbers 

• Select the cells, columns, or rows that contain numbers you want to format.  Select 
more than one column or row at a time by holding down your [Ctrl] key while 
selecting. 

• On the Home Tab, in the Number Group, select the format you want, or click the 

arrow in the lower right hand corner of the Group   and select the 
desired format from there.  All the cells in the columns you selected in Step 1 will 
be formatted at the same time.  

OR 
• Right click on one of the selected columns, and select Format Cells. 

Example 1:  Format the Co_amt and Prem columns to Comma Style in the Number 
Group 
Example 2:  Format the Prem column using the Number tab.  This time format the 
negative numbers to look like this (50.00). 

 

 

Wrap Text 
• Home tab, Alignment Group - Wrap Text – data in the cell will wrap to fit the 

column width.  If all the text is not visible, it may be because the row is set to a 
specific height. 
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Sort 
Make sure the active cell is in a table column containing data.  Sorting is under the Data 
tab, Sort & Filter group.   
 

• Place your cursor in a cell in the column you want sorted and select A-Z or Z-A  
OR 
• Place your cursor in a cell in any column and select Sort.  To add more sorting 

options, select Add Level.  When all items to be sorted are select, click OK. 
 
WARNING:  If you highlight a column, and then click Sort or A-Z, Z-A, Excel will only sort 
the data in the column you highlighted, not all the data in the worksheet!!! 
 
Depending on the format of the data in the column you want to sort, the A-Z and Z-A sort 
options will change.  You can see how it will sort by hovering your cursor over the A-Z or 
Z-A buttons: 
 

   
 
 
Example 1:  Sort the BOB12-31-2012 Worksheet by Pol_type column. 
Example 2:  Sort the BOB12-31-2012 Worksheet by Producer, then by Policy Index 
Example 3:  Sort the BOB12-31-2012 Worksheet by Producer, then by Commission 
Amount in Descending Order (largest to smallest) 

Subtotal 
In order to evaluate your data, you can use subtotals.  The following steps take you 
through the basic subtotal function. 

• In order to subtotal your data you  must first SORT it into a logical order following 
the steps above. 

• On the Data ribbon, Outline tab, select Subtotal 
• Choose each  level of subtotal along with ascending or descending options. 
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• Once you have finished subtotaling you will see an outline option at the far-left 

side of your screen.  If you click on the 2 or 1 you will collapse your outline. 

 
 

 
 

Taking subtotals to another level: 
• When you Subtotal you are given the additional options of Replace Current 

Subtotals – you will usually want to do this unless you are doing multiple 
levels such a by producer, by customer.  The next is Page Break Between 
Groups which allows you to print the report easily giving each group their part. 

• Finally it is nice for a summary purpose to collapse the totals (click on the 
outline number 2 on the far left) you can then sort in ascending or descending 
order.  In our example, this will easily give you a listing of your total premium or 
commission volume – largest to smallest, by policy type. 

 
Example:  Subtotal the commission and premium columns by policy type in your 
worksheet.  (Be sure you have first SORTED the data by Policy Type!) Now SORT the 
SUBTOTALS by commission from Largest to Smallest. 
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Using Summary Subtotaled Data Only – Remove the Detail 
Select visible cells only to copy and paste totals from a subtotaled listing.  Use for 
copying just totals or use for quick formatting of only the totals. 

• To work with only the subtotals, on the 
Home tab, Find & Select group, Go To 
Special and choose the option Visible 
Cells Only 

• Right click, Copy 

• Click in new a Worksheet, Right click, 
Paste 

• You may still have subtotal columns on 
the left side of your new worksheet.  To 
remove them, click on the Data ribbon, 
Subtotal, and click Remove All. 

 

 
Example:  Copy and Paste your subtotaled data into a new worksheet. 

Insert Column / Row 
• Select a single cell. 
• On the Home Tab, in the Cells Group, click the arrow next to Insert 
• Select Insert Sheet Column or Insert Sheet Row 
OR 
• Right click on the selected column or row, and select Insert. 

Example:  On the worksheet named “BOB12-31-2012”, Insert a column to the left of 
Column O (Pol_status).  Name the column Net Premium. 

Basic Formula 
Formulas are equations that perform calculations on values in your worksheet.  A formula 
always starts with the equal sign. 
  
Example:  Create a formula to calculate the Net Premium. 

• Click in cell O2 in the worksheet named “Billing Screen 10-31-08”. This should be 
the column created called “Net Premium” 

• Type = 
• Click on cell N2 (Prem) 
• Type – 
• Click on cell L2 (Co_amt) 
• Click Enter 
• AutoFill the formula into the remaining cells in the column 
• Name the column Net Premium 
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Copy-Paste Special-Values 
This will convert a formula to a value in a cell. 
 
Example:  Convert the Net Premium column from a formula to a value 

• Select the column containing the Net Premium Formula 
• Right click, Copy  
• Right click, Paste Special - Values 

 

AutoSum Function -  

Use the Auto Sum function  to quickly total data in a column or a row.  Click 
on an empty cell below a column of numbers or to the right of a row of numbers, and 

then click .  Click  again to accept the range of data chosen by 
Excel or click Enter. 
 
Example:  Total the Producer Commission Column. 
Example:  Copy and Paste the formula to the Prem and Net Premium columns 

Filter data   
This is truly one of the handiest features in Excel.  Using this you can filter your 
spreadsheet so that only certain data shows or doesn’t show.  It makes auditing your 
data a breeze. 
 

If you run multiple reports that are basically the same, but with slightly different criteria, 
filters may be just what you are looking for.  Run just one report and filter the data in 
Excel.  You can copy and paste filtered data to another spreadsheet without taking any 
of the other data as when working with subtotals. 

 
Filters are super easy to use.  Simply click on Data  - Sort and Filter – Filter.  This puts 
little dropdown arrows next to your column headers.  If you click on one of those arrows, 
you’ll see a number of choices including (A-Z), (Z-A), (Filters…), and then an alphabetized 
listing of everything entered in that column, and at the bottom of the list you may see the 
words Blanks and NonBlanks.   
 
Click on one of the filters, or select multiple filters to analyze your data quickly. 
 
One huge advantage of filtering over subtotaling, is the ability to copy and paste the 
filtered data into a new worksheet or workbook without having to  use the Visible Cells 
only tool. 
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Examples:  Turn on Filter on Sheet “Search-Pol Curr-Active” 

• Filter for Zero Premium billing screens 
• Filter for Zero Commission Amounts 
• Filter for missing Producer Codes 
• Filter for Producer CJH for Company AOI 
• Filter for Policies Effective between 1/1/2013 and 5/31/2013 
• Filter for Policies with Customer Code CENTR-1 
• Copy and Paste the results of each filter to a new Worksheet.  
• Name each worksheet accordingly. 
• Insert rows, and add a Title to each sheet. 

 
WARNING:  The AutoFilter list may not display all the unique visible items in a 
column as expected, if there are more than 10,000 unique items in the list.  
This is a limitation in Excel. 
 

Printing 
• Define a print area 

o Highlight the desired print area 
o Page Layout tab, Page Setup group, Print Area – select Set Print Area 

 
• Repeat Rows/Columns on each printed page 

o Page Layout tab, Page Setup group, Print Titles – enter the range of rows 
to repeat at the top of each page, and enter the range of columns to repeat 
on the left side of each page 

 
 

• Make a worksheet fit the printed page 
o Page Layout tab, Scale to Fit group – Width – change the default setting 

(Automatic) to 1 (or the desired amount) 
 

 
• Print Preview 

o File, Print – Print Preview OR [Ctrl-F2] 
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APPENDIX I 

Sample Search-Customers, Policies Current Criteria/Fields 
1. From TAM Homebase, Click Reports – Search 
2. Search – Customers 
3. Policies – Current 
4. Output Destination – Excel-Raw Data 

 
 

5. Criteria Tab 
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a. Policy Status – Only ACTIVE policy statuses (NEW, REN, REI, REW – 

whichever codes YOUR agency uses) 
b. Expiration Date – You might want to limit the Expiration Date range to 

include only billing screens that are expiring after the month you are 
closing.  For example, if you are running the report at December 31, 2013, 
choose an Expiration Date range of 1/01/2014 thru 12/31/2029.  This will 
keep all the old billing screens with inaccurate policy statuses from 
skewing the report, but include all expiration dates in the next 15 years. 

c. Record Listings – Choose “List Each Time Found” if you are entering the 
Commission and Premium on EITHER the main Package line OR the 
subsections, but NOT BOTH.  If in your agency, the premium and 
commission are entered on BOTH the main package line AND the 
subsections, choose “List Each Time Found”, and then manipulate in Excel 
to get only the commission and premium on the main package. 

6. FIELDS/SORT (Include as many as desired, but be consistent each month) 
Field Name Excel Column Title 
Customer/Pol_idx Number Pol_polidx 
Agency Pol_agcy 
Branch Pol_brch 
Department Pol_dept 
Policy Number Pol 
Policy Effective Date Effective 
Policy Expiration Date Expires 
Date First Written Fwritten 
Policy Type Pol_type 
Policy Type Group Typegroup 
Issuing Company Ico 
Billing Company Bco 
Type of Agency Commission Co_type 
Total Commission Amount Co_amt 
Total Commission % Com_p 
Billing Mode Bill 
Producer One Pr1 
Producer One Comm % Pr_p 
Producer One Comm $ Pr_amt1 
Producer Two Pr2 
Producer Two Comm % Pr_p2 
Producer Two Comm $ Pr_amt2 
Producer Three Pr3 
Producer Three Comm % Pr_p3 
Producer Three Comm $ Pr_amt3 
Policy Premium Prem 
Policy Status Pol_status 
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Policy Customer Service Rep Pol_csr 
Customer Number Cust_rec 
Customer Name Cust_name 

 

7.  When finished selecting fields, click Run. 

8.  Always choose the 3rd radio button to “Send output to 
a temporary file”.  Click OK 

9.  Click “Yes” to create a new temporary file. 

10.  Click “Yes” to Load Excel. 
• Excel will open with your Billing Screen data.   
• SAVE EXCEL REPORT. 

a. Suggestion:  Save the report each month to a folder called Active Billing 
Screens.  Name each file using the format:  ABSYearMonthDay 

November, 2009 would be ABS20091130 
December, 2009 would be ABS20091231 

This way all the billing screen “snapshots” will be in chronological order in 
the Active Billing Screen folder. 
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• Print Preview 

o File, Print Preview OR [Ctrl-F2] 
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